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Define your database

When you launch VSP, it's helpful to re-label the

headings on the left-hand side to more accurately reflect

Adoration schedules.

1. Click the “Edit” menu at the top of the VSP window.

2. Select “Change label used for Volunteer.”

3. Change the word “Volunteer” to “Adorer” (enter

the singular form of the word and VSP will pluralize

as needed).
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a Enter your jobs

Start by setting up your “Adorer” job. Later you will be able to

specify how many Adorers should be scheduled at each time.

1. Click on the Jobs pane.

2. Click the “+” button and select “New Job."

3. Name your job.

4. To ensure everyone is added as an Adorer, select

“Qualify new adorers for job by default.”

5. Click “OK”
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Creating a schedule

After you have entered all your jobs, create a schedule. Note that
all the shifts and jobs that will occur within this time period will be

included on this “master schedule.”

1. Click on the Schedules pane.

2. Enter the start and end dates for a schedule, and then

click the “Create...” button.

3. Click on a day in the calendar on which one of your shifts
takes place, and then click the “New Shift...” button at the

top of the window.

4. In the dialog that appears, set the start and end times
for the shift. (Usually Adoration shifts are one hour in
length, every hour.)

5. If the shift repeats on other days of the week, or monthly
or yearly, use the controls under the “Repeats” heading to

set up the appropriate repeating pattern.
6. Specify how many Adorers are required for this shift.
7. Click “OK”

8. Repeat this process to set up 24 separate, one-hour shifts

for Adoration.

When you have finished creating all your shifts:

1. Choose “Save” from the File menu at the top of the

schedule window.

2. A dialog will open asking you to enter a name for the
schedule. Be sure the box is checked to “Make this
schedule live now” and select the option to “Just use the

default layout for now.”

3. Click “OK”

This schedule will be saved to the VSP web servers. To open it later, click on the

Schedules pane on the left hand side of VSP's main screen.
Please choose a name for this schedule:

Schedule Sep 1 - Sep 30

Make this schedule live now so volunteers can see their assignments online

When a schedule is live, volunteers can see their scheduled times in the Web
Terminal and sign up for unfilled positions. (If you don't make this schedule live
now, you can do so later by choosing "Make schedule live" from the File

O customize the online layout ("Live Schedule Post") now (what's this?)

© Just use the default layout for now (can be changed later)




Enter your Adorers

There are several ways to go about entering your Adorers: manually,

via import, or via email.

[\ EREWA enter Adorers to customize their
complete profile.

1. Click the “+” button on the right side of the

Adorers pane.

2. Add the Adorer name, email, and any other
information about that Adorer that you want

to track.
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Watch this video to learn how to set up a spreadsheet and

import your volunteers.

1. Go to File - Import Adorers.

2. From the available fields, select the fields
to import in the order they appear on

your spreadsheet.

3. Choose whether to qualify everyone from the

spreadsheet as Adorer.

4. Click the “Import” and choose your spreadsheet.

Import Adorers

To use the Import Adorers feature, you must have your adorer information in a text (.txt) file or
comma separated value (.csv) file. See the Volunteer Scheduler Pro documentation for detailed
instructions on how to create a suitable .txt or .csv file from an existing roster or data export.

Select the fields you are importing and then use the Add button below to move them into the list on
the right. Make sure you add the fields in the exact order they appear in your .txt or .csv file.
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https://www.volunteerschedulerpro.com/video/80

AN ENET R T EER TG N E ) {l to a list of contacts

As people enroll, they are added as Adorers to the database.
Watch this video for a walkthrough of the full enrollment form

setup process.

To see the enrollment form:

1. Click on the Web Terminal pane on the left hand side
of VSP’s main screen.

2. At the top of the pane, click “Web Terminal Settings”
and then click the Enrollments pane on the left.

3. The Enrollment URL at the top is the direct link to

your form, which you can click this to view or to send

to Adorers.

TIP

Recommended settings

The remaining settings on the right-hand side of
the dialog are used to track Adorer availability
and preferences. You will not necessarily need
to use these sections if you are primarily having
Adorers assigned to repeating shifts. However, it
may be beneficial to enter Shift Preferences and
Unavailable dates/times to help determine what

type of sub requests people will receive.

For example, if an Adorer has 8AM - 9AM and
9 AM - 10 AM as shift preferences and selects
“Schedule only at these shifts,” then by default
they will only receive substitute requests for
those times.


https://www.volunteerschedulerpro.com/video/86

Scheduling volunteers

VSP accommodates many forms of scheduling, and you can mix
and match to find the right method for your organization. The most
common method of scheduling Adorers is to schedule them with

repeating “preassignments” that occur at regular intervals.

Set Adorers to repeat on a pattern

Click here for a video on how to set up rotating assignments.

1. Open the saved schedule you created in step 2.

2. Click on one of the empty positions in a shift and you'll
see that the Adorer list on the right side of the window
shows the Adorers who are eligible and available to fill

the selected position.

3. To fill the position with one of the Adorers in the list,

double-click or drag-and-drop the Adorer to assign them.

4., After manually placing an Adorer on the schedule, click

the “Repeats” button.
5. Set the repeating pattern for the chosen Adorer.
6. Click “OK." The Adorer will now be placed in the rotating

pattern on this and all future schedules.

SNSRI Allow Adorers to sign up for shifts online

1. Click the “Log in as...” button found in the lower right-
hand corner of the Web Terminal pane.

2. Choose an Adorer to log in to the Web Terminal as if you

were that person.

3. Click on the “Full Schedules” tab at the top of the page,

and then click on an unfilled position to sign up for a shift.

4. Once you submit the request, go back into VSP (minimize
or close the web browser window) and click on the Web
Forms pane on the left-hand side of VSP’s main screen.
You'll see an “Assignment form” in the list that represents
the assignment request you submitted online. Click the

“Process Form” button.

5. You can optionally set up these forms to be automatically
processed so that the assignments are made in real time as

soon as the forms are submitted.


https://www.volunteerschedulerpro.com/video/81
https://rotundasoftware.screenstepslive.com/s/VSP/m/58335/l/717677-how-can-i-set-up-my-web-forms-to-process-automatically
https://rotundasoftware.screenstepslive.com/s/VSP/m/58335/l/717677-how-can-i-set-up-my-web-forms-to-process-automatically

TIP

Customizing VSP for your organization

Custom fields, available in the Standard edition, can be used to
collect and track Adorer information that is not reflected in the
predetermined fields within VSP. Examples of common custom fields
include t-shirt size, birthday, certifications, and more. Custom fields
can be added to the enrollment form and the My Profile form so that

Adorers can update these fields themselves online.

Click here for a video on how to set up custom fields.

1. Go to the Adorers pane and click “New Adorer...”

2. In the new window, click the “Edit Custom
Fields...” button.

3. Click the “Create New Field” button.

4. You have different options for custom fields: text,
number, date, checkbox, and list of options. Once
you create the field it will appear in the main part of

the screen.

5. Click “OK” once you have added all the custom fields you

wish to track.

Web Terminal settings allow you to further customize how Adorers
interact with VSP through the Web Terminal. (NOTE: Web Terminal

settings are not available during the 15-day free trial.)

1. Click on the Web Terminal pane on the left-hand side of
VSP’s main screen.

2. Click the “Web Terminal Settings” button at the top of the

Home tab.

In the dialog that appears, you will find a variety of customization

options. Among many other options, you can:

e Customize the text of automatic email reminders
e Turn on automatic text message (SMS) reminders

e Turn on automatic processing for web forms, so that
requests that volunteers make through the Web Terminal
are processed immediately rather than held for manual

processing at a later time.
e Brand the Web Terminal with your organization’s logo

e Customize the profile information that Adorers can
update in the My Profile tab. For instance, you can hide
the shift preferences and unavailable times areas, or you

may include custom fields on the My Profile tab.


https://www.volunteerschedulerpro.com/video/92
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A Dear Nancy Austin, Clifford Baker
When you are ready, send your Adorers an email through the _ Theodore Beck
We are pleased to announce that we'll be using an online system that
Announcements pane to let them know how to |Og in to the Web allows you to specify the times that do and do not work well for you to Allen Bennett
serve, check your schedule from anywhere and easily find a substitute Annie Bowman
. . when you can't make it. For information and help on how to use this N
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1. Click on the Announcements pane on the left-hand side Username: naustin sarah Brooks
, . Password: 2h1t3h Theresa Brown
of VSP’s main screen. Craig Burke

Don't forget that if you have an iOS or Android device, you can use the VSP
. - . . mobile app! After downloading, you'll need the following Organization 1D
2. Click the “+” button in the upper right and select tosign in: VSP Laura Campbell

Enter your Web Terminal Username and Password to log in. Martin Campbell

Todd Burns.

“Templates” and then “Preconfigured.”

Earl Carr -

Then, all you need to do is open the VSP app to see your scheduled dates,
request and accept subs, and update your profile! Show only final recipients

3. Select one of the “Introductory email” templates to send

your Adorers that will provide them with the link to your
Web Terminal homepage and their personal usernames -

and passwords that are automatically generated for them . S
We also recommend that you post a link to your Web Terminal’s

them by VSP. Tokens enclosed in {{curly brackets}} will be L .
home page on your organization’s website so that your Adorers can

replaced with the appropriate information for each . L .
access their schedules by visiting your organization’s site.

volunteer when the email is sent. Feel free to customize

the email to best suit your organization’s needs - you can
add and remove text and tokens as needed by typing into 1. Go to the Web Terminal pane on VSP’s main screen and

the text box then click the “Copy URL” button in the top right corner

of the pane.
4. Click the “Preview” button, then click on a

. . . )
Adorer’s name to see how the email will look when sent 2. Send an email to your organization’s webmaster and

to each Adorer choose “Paste” from the “Edit” menu to paste the link into

the email with a request to post it on your site.



Conclusion

Congratulations! You have completed the setup work of entering your jobs, creating a schedule, and adding Adorers. You should now

have a clearer idea of how VSP can work for your organization.
For more help getting started with VSP, visit our Help Center. There, you will find:

e Video tutorials on specific features in the program, including those not covered in this guide, such as how to print the

schedule, customize the online layouts, and send text messages

e Step-by-step instructions for many common questions and setups

e The user manual, which helps explain the many different options found within the program

Need additional help?
Contact support by sending in your data files (Help - Send Data Files to Tech Support) or call us at 888-877-3640.
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